MS Access

Microsoft Access is a relational database management system for windows. Using this package, following tasks can be performed.

- Organize data into manageable related units
- Enter, modify and locate data
- Extract subsets of data based on specific criteria
- Create custom forms and reports
- Automate common database tasks
- Graph database relationships
- Add clipart to forms and reports
- Create macros for automating various functions
- Create database applications, consisting of modules linked through menus, dialog boxes, and command buttons.
- In Access, the term Database refers to a single file that contains a collection of information. Each Access Database consists of tables, queries, forms reports, macros and modules

Database Concepts

Field Names

These should be meaningful, without spaces or punctuation, such as SNAME (surname), FNAME (first name), DOB (date of birth), ADDRESS1 (first line of address), TOWN, PCODE, PHONE etc. You cannot have two fields with the same name.

Field Types

- Text for text and whole numbers that aren’t going to be used in calculations (e.g., age, phone number)
- Date/Time for dates and time
- Numbers for decimals and numbers that are going to be used in calculations, e.g. sales figures
- Currency for money
- Yes/No for true/false logical values, e.g. a “married” field, field could be logical.

Field length

This has to be fixed, so you need to plan your database structure beforehand (although you can alter the length later).
**Required Fields**

This box is for when you want to force the user to enter data in a field

**Primary keys**

These are used to sort the records to allow fast access. Access encourages you choose one field as the primary key field, and then sorts the records on this field. However, only one record with the same value is allowed in the primary key field, for example if you choose surname for the primary key, you can only have one Smith, Jones etc. For this reason, you should always choose a numeric or a counter field for the primary key: do not use surname as the primary key field.

**Manipulating Database**

**Creating a Database Structure**

**Starting MS-Access**

- Switch on your computer and then click **Start → Programs → Microsoft(MS) Access**

You will get the following screen.
- Click on **Create a New Database Using Blank Database** and click **OK** button.

![Create New Database](image)

- Type *Employee* in the name box as shown in this screen. Click **Create** button.

![Create Database](image)

- Click **Create** button and you will get the following screen.
By default Tables tab is selected. You can select other tabs (Queries, Forms, Reports, Macros or Modules)

Creating a New Table

Click New button. You will get a screen similar to this.

You are now going to create a database table with the following fields and enter some records into the database:
Field Names

**EmpID, Surname, DOB, phone, married, wage, service.**

- Click **Design View** and then click **OK** button.

- In the first row of the **Field Name** box type **EmpID** then press **tab** once. The screen should look like this.
Move the mouse pointer down to the **Field Size** box. The default size is 50. Change the size as 10.

Move the mouse pointer to the **Required** box and click. A down arrow will appear. Click on this and click **Yes**. This stops users from entering a record without filling in the surname.

Move to the next field, and call it **DOB** for date of birth.

Press tab to move to the **Data Type** box, click once in the box to display the down arrow, then click once on the arrow. Click once on **Date/Time**.

Move to the third field name, call it **phone** with data type **text** and field size 12.

The next field is **married**, field type **Yes/No**.

Now create a field **wage** of type **currency**, and a field **service** of type **number**, Field Size single. We have now finished creating our database table structure.

Click on **File** menu, **Save** to display this box.
Type the name **Staff** in the *Table Name* box and click **OK**.

Click **File** menu and then click **Close** to close the table structure dialog box.

Click **File** menu and then click **Close** to close the *Employee* database.

**Opening Database**

Click **File** menu and then click **Open Database** option to open *Employee* database.

Open **Staff** table by selecting **Staff** and clicking the **Open** button.

A data entry screen like this will appear.
Enter the following records into the table:

<table>
<thead>
<tr>
<th>Surname</th>
<th>DOB</th>
<th>phone</th>
<th>married</th>
<th>salary</th>
<th>service</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kumar</td>
<td>08/09/49</td>
<td>7057937</td>
<td>Yes</td>
<td>2500</td>
<td>25</td>
</tr>
<tr>
<td>Mahesh</td>
<td>09/05/74</td>
<td>7067894</td>
<td>No</td>
<td>300</td>
<td>2</td>
</tr>
<tr>
<td>Mohan</td>
<td>07/07/63</td>
<td>7094564</td>
<td>Yes</td>
<td>100</td>
<td>10</td>
</tr>
</tbody>
</table>

Now enter some more records into the table. Click File menu, Close to save your work and close the table and database.
Modifying database structure

Follow the following steps to modify *Employees* database structure.

- Open **Employees** database, and then open **Staff** table.

- Click on the **View** menu, click **Design View** to get this screen.
Access has two main views: *Data Sheet View* for working with data, and *Design View*, for creating and changing database structures, reports, forms and queries.

- Click on the *Indexed field* box to display a drop-down menu; the box to the right explains the options. Read this box now.

- Double-click the *Cancel* button in the top left of your screen and then click **OK** button.

**Set or Change the primary key**
Adding a new record

- Open Employee database and then open Staff table.
- Move to last record and then press down arrow key. You will get a blank record.
- Now you can enter a new record as shown below:

  Kamal  08-04-79  7658905  Yes  $2000  5

- Now save the file by clicking File menu and then Save option.

Editing an existing record

- Open Employee database and then open Staff table.
- Move the mouse pointer to the record which you want to edit and click.
- Now change the data as you desire and then save the file.

Ex: Change the Surname field of 5th record to Kiddy as shown below:
Deleting a record

- Open **Employee** database and then open **Staff** table.
- Select the record which you want to delete and then press **Delete** key. You will get the following screen.

![Screen for deleting a record](image)

- Click **Yes** button to delete current record.

Displaying and searching for data

Creating a query

- Open **Employee** database.
- Click **Query** tab and then click **New** button. This screen will appear.
Click **Design View** and then click **OK** button. This screen will appear.

Click **Staff**, then click **Add** button to base the query on the **Staff** table.

Click on **Close** in the **Add Table** box. The fields of the **Staff** table are displayed.

Click on Surname, hold the mouse button down and drag the field into the field box like in this screen.
Repeat for **DOB** and **phone** fields, dragging them into the second and third columns. When you have finished, click **File, Close** and click **Yes** to save changes to query.

Name your query as **NameQuery** as shown below and then click **OK** button.

Your query is now saved. Look at the query list box and scroll down until you see the **Name Query** query.

Click on **Name Query** to select it, then click the **Open** button. This screen will appear.
Your query should display only the contents of Surname, DOB and phone fields.

Create a Query

Microsoft Access can often create a query for you so you don't have to design one from scratch.

- To create a query to use as the basis of a form or report, try the form or report wizards. They create the form or report, and if it's based on more than one table, they also create its underlying SQL statement. If you want, you can save the SQL statement as a query.

- To easily reate queries that you want to run independently or base multiple forms and reports on, try one of the query wizards. Query wizards do all the basic work for you after you provide answers to a series of questions. Even if you've created many queries, you may want to use a wizard to quickly design the query. Then you can switch to Design view to customize it.

- To create queries from filters you created using Filter By Form, Filter By Selection, or Filter For Input, save the filter as a query.

If none of these methods satisfies your needs, you can create the query from scratch in query Design view.

Create a form

You can create a form on your own or you can have Microsoft Access create your form for you using a Form Wizard. A Form Wizard speeds up the process of creating a form because it does all the basic work for you. When you use a Form Wizard, Microsoft Access prompts you for information and creates a form based on your answers. Even if you've created many forms, you may want to use a Form Wizard to quickly
lay out all the controls on your form. Then you can switch to Design view to customize your form.

If you just want to create a simple single-column form, you can use the New Object button.

**Create a form using AutoForm**

AutoForm creates a form that displays all fields and records in the selected table or query. Each field appears on a separate line with a label to its left.

- In the Database window, click the Tables or Queries tab.
- Click the table or query you want to base the form on, or open the table or query in any view.
- Click the arrow next to the New Object button on the toolbar, and then click AutoForm.

**Create a form with a wizard**

1. In the Database window, click the Forms tab.
2. Click New.
3. In the New Form dialog box, click the wizard that you want to use. A description of the wizard appears in the left side of the dialog box.
4. Click the name of the table or query that includes the data you want to base your form on.
5. You can specify the record source for the form in the wizard.
6. Click **OK**.
7. If you clicked **Form Wizard, Chart Wizard, or PivotTable Wizard**, follow the directions in the wizard dialog boxes. If you clicked **AutoForm: Columnar, AutoForm: Tabular, or AutoForm: Datasheet**, Microsoft Access automatically creates your form.

Create a form based on more than one table

Using a Form Wizard is the simplest and fastest way to create a form that brings data together from more than one table. A Form Wizard speeds up the process of creating a form because it does all the basic work for you. In the first screen of a Form Wizard, you can pick the fields you want to include in your form. These fields can be from one table or from multiple tables. When you use a Form Wizard to create a multiple-table form, Microsoft Access creates an *SQL statement* behind the form. The SQL statement includes the information about which tables and fields to use.

You can use a Form Wizard to create a form that displays data from multiple tables as a "flat form" or as a "hierarchical form." Of this type a hierarchical form is a form with one or more subforms. Subforms are useful if you want to show data from tables that have a one-to-many relationship.

You may want to present your data hierarchically without using a subform. For example, if you have a form with lots of controls, you may not have room for a subform. In this case, you can use a Form Wizard to create synchronized forms. When you click a command button on one form, it opens another form that's synchronized with the record on the first form.

---

7 The **Relationships** dialog box is displayed. Check the field names displayed in the two columns to ensure they are correct. You can change them if necessary.

Set the relationship options if necessary. For information about a specific item in the **Relationships** dialog box, click the question mark button ![Help](?), and then click the item.

8 Click the **Create** button to create the relationship.

9 Repeat steps 5 through 8 for each pair of tables you want to relate.

When you close the **Relationships** window, Microsoft Access asks if you want to save the layout. Whether you save the layout or not, the relationships you create are saved in the database.

**Notes**

- If you need to view all the relationships defined in the database, click **Show All Relationships** ![All Relationships](?) on the toolbar. To view only the relationships defined for a particular table, click the table, and then click **Show Direct Relationships** ![Direct Relationships](?) on the toolbar.

- If you need to make a change to the design of a table, you can right-click the table you want to change, and then click **Design Table**.

- You can create relationships using queries as well as tables. However, referential integrity isn't enforced with queries.

- To create a relationship between a table and itself, add that table twice. This is useful in situations where you need to perform a lookup within the same table. For example, in the Employees table in the Northwind sample database, a relationship has been defined between the EmployeeID and ReportsTo fields, so that the ReportsTo field can display employee data from a matching EmployeeID.
Define Relationships between Tables

1. Close any tables you have open. You can't create or modify relationships between open tables.
2. If you haven't already done so, switch to the Database window. You can press F11 to switch to the Database window from any other window.
3. Click Relationships on the toolbar.
4. If your database doesn't have any relationships defined, the Add Tables/Queries box will automatically be displayed. If you need to add the tables you want to relate and the Add Table dialog box isn't displayed, click Show Table on the toolbar. If the tables you want to relate are already displayed, skip to step 6.
5. Double-click the names of the tables you want to relate, and then close the Add Tables/Queries dialog box.
6. Drag the field that you want to relate from one table to the related field in the other table. To drag multiple fields, press the CTRL key and click each field before dragging them.

In most cases, you drag the primary key field (which is displayed in bold text) from one table to a similar field (often with the same name) called the foreign key in the other table. The related fields don't have to have the same names, but they must have the same data type (with two exceptions) and contain the same kind of information. In addition, when the matching fields are Number fields, they must have the same FieldSize property setting. The two exceptions to matching data types are that you can match an AutoNumber field with a Number field whose FieldSize property is set to Long Integer; and you can match an AutoNumber field with a Number field if both fields have their FieldSize property set to Replication ID.

Create a report

You can create a report on your own or you can have Microsoft Access create a report for you using a Report Wizard. A Report Wizard speeds up the process of creating a report because it does all the basic work for you. When you use a Report Wizard, it prompts you for information and creates a report based on your answers. Even if you've created many reports, you may want to use a Report Wizard to quickly lay out your report. Then you can switch to Design view to customize it.

Create a report using AutoReport

AutoReport creates a report that displays all fields and records in the underlying table or query.

- In the Database window, click the Reports tab.
- Click New.
- In the New Report dialog box, click one of the following wizards:
**AutoReport: Columnar.** Each field appears on a separate line with a label to its left.

**AutoReport: Tabular.** The fields in each record appear on one line, and the labels print once at the top of each page.

- Click the table or query that contains the data you want to base your report on.
- Click **OK**.

Microsoft Access applies the last autoformat you used to the report. If you haven't created a report with a wizard before or haven't used the **AutoFormat** command on the **Format** menu, it uses the Standard autoformat.

**Tip:** You can also create a single-column report based on the open table or query or on the table or query selected in the Database window. Click **AutoReport** on the **Insert** menu, or click the arrow next to the **New Object button** on the toolbar, and then click **AutoReport**. Reports created with this method have only detail records (no report header or page header and footer).

**Create a report with a wizard**

1. In the **Database window**, click the **Reports** tab.
2. Click **New**.
3. In the **New Report** dialog box, click the wizard that you want to use. A description of the wizard appears in the left side of the dialog box.
4. Click the table or query that contains the data you want to base your report on.
5. Click **OK**.

**Note:** Microsoft Access uses this table or query as the default record source for the report. However, you can change the record source in the wizard and select fields from other tables and queries.

**Create a report based on more than one table**

Using the Report Wizard is the simplest and fastest way to create a report that brings data together from more than one table. The Report Wizard speeds up the process of creating a report because it does all the basic work for you. In the first screen of the Report Wizard, you can pick the fields you want to include in your report. These fields can be from one table or from multiple tables. When you use the Report Wizard to create a multiple-table report, Microsoft Access creates a query behind the report. The query includes the information about which tables and fields to use.

If you want to create a report on your own, you can create a query and base the report on it.

***